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Funcionalidad Básica 
¿Cómo func iona  e l  p i za r rón  
in te rac t i vo  SMART Board?  
El pizarrón interactivo SMART Board  es muy fácil de usar y viene lleno de 
características. 

La pantalla sensible a tacto se conecta a su computadora y al proyector 
digital para mostrar la imagen de su computadora. Puede entonces tomar 
el control de las Aplicaciones de su computadora directamente de la 
pantalla, escribir notas con tinta digital y guardar su trabajo para 
compartirlo más adelante. 
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¿Cómo Funciona el Pizarrón interactivo SMART Board? 
El pizarrón interactivo SMART Board es sensible al tacto y opera como parte de un sistema que 
incluye computadora y proyector.  
 

 
• La computadora envía una imagen de una aplicación al proyector.  

 
• El proyector lanza la imagen en el pizarrón interactivo. 

 
• El pizarrón interactivo actúa tanto como monitor como dispositivo de entrada, 

permitiéndole controlar cualquier aplicación al simplemente tocar el pizarrón interactivo.  
 
Le puede ayudar el pensar en su pizarrón interactivo del mismo modo en que lo hace con su 
mouse o teclado – es un dispositivo de entrada que le permite tomar el control de las 
aplicaciones en su computadora.  
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Trabajando con Aplicaciones en su Pizarrón Interactivo SMART Board  
Si una aplicación se ejecuta en su computadora, puede tomar control de ella desde el pizarrón 
interactivo.  

Su Dedo es su Mouse 
Una presión sobre un pizarrón interactivo SMART Board es lo 
mismo que un clic con botón izquierdo. Abra una aplicación del 
mismo modo que lo hace en el escritorio de su computadora, pero 
en lugar de utilizar su Mouse para seleccionar y abrir archivos, sólo 
presione o presione dos veces la aplicación con su dedo.  
 
Orientar el pizarrón interactivo asegurará que el cursor está 
alineado con la presión de su dedo. La orientación se discute con 
detalle en la página cinco. 

SMART Pen Tray (Bandeja de Plumas) 
La bandeja de plumas consiste en cuatro ranuras para plumas identificadas por colores y una 
ranura para el borrador. Cada ranura tiene un sensor óptico para identificar cuándo son 
levantadas las plumas o el borrador de sus ranuras. El botón superior de la bandeja es utilizado 
para ejecutar el teclado en pantalla. El botón inferior de la bandeja es utilizado para hacer de la 
segunda presión en el pizarrón un clic derecho.  
 

 
 
 
 
 

Las Plumas  
Para escribir sobe su escritirio, imagen o aplicación, tome una de las plumas de la bandeja y 
escriba en el pizarrón interactivo.  
 
Para escribir de un color diferente, tome otra pluma. El reconocimiento de color viene de las 
ranuras de la bandeja y no de las plumas en sí. Debe colocar cada pluma en su respectiva 
ranura para evitar confusión.  

 

 

Borrador Pluma 
Negra 

Pluma 
Azul 

Pluma 
Verde 

Pluma 
Roja Botones de  

La bandeja 
Luz Indicadora 
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Teclado en Pantalla 
Teclee o edite texto sin dejar el pizarrón interactivo. 
 
Presione el botón de Teclado de la bandeja de plumas para ejecutar el Teclado en Pantalla.  
 
 

 
 

Menú desplegable de teclado: le permite seleccinar qué teclado le 
gustaría utilizar. El teclado clásico (Classic) se ve como el teclado 
regular de una computadora. El Teclado Simple está organizado en 
orden alfabético que es útil al enseñar a estudiantes jóvenes. Otros 
teclados incluyen Number Pad, Write, Shortcut and Simple Caps. 
 
 
Botón de Flecha: Presione el botón de Flecha para abrir Preview 
Pane. Cuando la ventana de vista preliminar (pane preview) esté 
abierta puede escribir una palabra  o frase completa antes de mandar información a una 
aplicación. Una vez que haya acabado de escribir, presione el botón Send y su texto 
será enviado a la aplicación activa.   
 

 
 
 

Consejo: 
Presione el botón de Ajustes de teclado y seleccione la cajilla para Display Keyboard para 
systemlogon.  El teclado en pantalla aparecerá al incitarse para abrir una sessión en su 
computadora.  

Botón de 
Teclado 

Teclado en pantalla con la Ventana de Vista Preliminar 
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Botón Derecho del 
Mouse 

 

  

Bóton Derecho del Mouse 
Presione el botón Derecho del Mouse en la bandeja para que su siguiente 
toque sea reconocido como un click derecho.  
 
Un gráfico en la parte inferior derecha de su pantalla aparecerá para recordarle que su siguiente 
toque será registrado como un clic derecho  
 
CONSEJO:  
En lugar de presionar el botón derecho del mouse, presione y mantenga en el área de la pantalla 
que quiere que el pizarrón interactivo reconozca como botón derecho. Después de uns segundos 
de presionar y mantener el área, el Menú de botón derecho aparecerá. 

Orientando su Pizarrón Interactivo SMART Board 
La orientación asegura que su toque es 
registrado apropiadamente cuando use el 
pizarrón interactivo. 
 
Por ejemplo, si está presionando el botón Start 
y el cursor aparece en otro lugar diferente a 
donde está presionando, intente orientando el 
pizarrón interactivo. Después de la orientación, 
el menú Start abrirá cuando lo presione. 
 
Para ejecutar la función “Orient”, presione y 
mantenga presionados ambos botones de la 
bandeja al mismo tiempo hasta que la pantalla 
de orientación aparezca. 
 

 
Luz Indicadora 
Su pizarrón interactivo SMART Board incluye una luz indicadora que muestra su estado.  
 
Color de la Luz Indicadora Estado  

Parpadeando verde y rojo La bandeja está encendiéndose 

Rojo estático La bandeja está recibiendo corriente, pero aún no se 
comunica con el software 

Verde estático La bandeja está completamente operativa 

 
NOTA: Si la luz está en rojo, trate de ejecutar SMART Board Tools. Usando el mouse, no su dedo, 
seleccione Start > Programs > SMART Board Software > SMART Board Tools. El ícono  
deberá ser visible en la esquina inferior derecha de su pantalla.   

Pantalla de orientación 
Botones de la 
Bandeja 
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Escribiendo Notas  
Hacer notas o dibujos al quitar una pluma de la bandeja y escribiendo en la superficie del 
pizarrón interactivo.  

La Capa de Transparencia 
Cuando se levanta una pluma de la bandeja un borde aparece 
alrededor del escritorio y la barra de herramientas “Floating Tools” 
se ejecuta. El borde indica que puede escribir en al escritorio y 
permanece hasta que todas las plumas y el borrador son devueltos 
a la bandeja y usted toca el pizarrón. Un primer toque al pizarrón, 
después de devolver todas las herramientas de la bandeja, quitará 
el borde y cualquier nota o dibujo que haya hecho.  
 
 
 

Ejemplo: Capa de Transparencia 

  
Antes de quitar la pluma de la bandeja 

 
Después de quitar la pluma 

 

Border appears 

Floating Tools 
toolbar appears 
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Capturando sus Notas y Dibujos 
Las herramientas Flotantes le dan una forma de capturar sus notas y 
dibujos.  
 

 
 
 
 
 

 
Para capturar un área de su escritorio, siga los siguientes pasos:  

1 Presione el bóton de Area Capture  en la barra de herramientas Flotantes. La 
herramienta Area Capture aparecerá.  
 

2 Presione en cualquier esquina del área que 
desea capturar, continúe presionando, 
arrastre el recuadro de selección hasta que 
rodee toda el área.  
 

3 Deje de presionar y su selección será 
capturada como un gráfico en Notebook – si 
Notebook no está abierto aún, se abrirá 
automáticamente cuando capture una parte 
de su pantalla. Guarde su archivo de 
Notebook seleccionando File > Save. 

 
 
CONSEJO:  
Presione el botón Area Capture, en seguida presione cualquier parte del pizarrón 
interactivo e inmediatamente después deje de presionar para capturar una imagen de 
toda su pantalla en Notebook.   

 

Restaurar sus Notas y Dibujos 
Si accidentalmente elimina su notas al tocar el pizarrón puede restaurarlas 
presionando el mensaje Click here to restore writing, localizado en la 
esquina inferior derecha de la pantalla. Puede entonces utilizar el botón Area 
Capture para guardar sus notas. 
 
Si usted no ve el mensaje Click here to restore writing siga estos pasos: 
 
1 Presione el icono SMART Board   en la Barra de tareas de Microsoft® Windows® en la 

esquina inferior derecha de su pantalla.  
 

2 Seleccione la barra de herramientas Flotantes del menú que aparece.   
 

3 Presione el botón Undo           para restaurar sus notas o dibujos.  

Area Capture (Captura de Área) : Presione 
para capturar un área de la pantalla. 
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Notas:
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Repaso: Hardware del Pizarrón Interactivo SMART Board y Funcionalidad Básica

1 Nombre los tres componentes requeridos para operar el pizarrón interactivo SMART Borrad. 

•  

•  

•  
 

2 ¿Cómo se da cuenta cuando el pizarrón interactivo esta listo para usarse? 

•  
 
 

3 Encierre en un círculo el botón de la bandeja de pluma que ejecuta el Teclado en Pantalla.  
 
 
 

 

 

4 Describa como iniciar el proceso de orientación. 

 
 

 
 

5 ¿Cómo da un clic derecho en el pizarrón interactivo? 
 
 

 
 
 

6 ¿Cuál de los siguientes botones usaría para capturar un área de su escritorio?  
 

            
 

7 Nombre dos formas de restaurar la escritura eliminada. 

•  

•  
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Respuestas: Hardware del Pizarrón Interactivo SMART Board y Funcionalidad 
Básica 

1 Usted necesitará un pizarrón interactivo, una computadora y un proyector digital.  

2 Una luz roja constante indica que el pizarrón  interactivo esta recibiendo energía. Una luz verde 
constante indica que el pizarrón  interactivo esta listo para ser usado. 
 

 

 

 
 

3 Presione y mantenga los dos botones en la bandeja de pluma. 

4 Presione el botón derecho del Mouse en la bandeja de pluma  – el botón de hasta abajo – para 
que su última presión sea reconocida como un clic derecho.  
 

5              
 

6 Presione el botón  Undo (deshacer) de la barra de herramientas Flotantes o el mensaje Click 
here to restore writing en la esquina inferior derecha de la pantalla. 
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Práctica: Funcionalidad Básica 
Su escuela o compañia ha reubicado uno de sus pizarrones interactivos SMART Board en un 
Nuevo salon ya que desde el anterior no podia accesar a Internet. Usted será la primera persona 
en unsarlo en su nuevo ambiente y mostrara a todos cómo pueden ser utilizados conjuntamente 
el pizarrón interactivo e Internet.  
 
Usted ha aprendido a traves de la experiencia que cada vez que alguien mueve algo, es una 
buena idea probarlo antes de impartir una lección o una presentación. La computadora, pizarrón 
interactivo SMART Board y proyector parecen trabajar apropiadamente cuando se enciende 
todo. La Luz Indicadora está en un verde estático, indicando que el software SMART board está 
corriendo. Sin embargo, cuando hace una doble presión en el ícono del buscador de Internet su 
cursor aparece a unos centímetros del lugar donde su dedo presionó.  
 
Orientando su pizarrón interactivo SMART Board 
Recuerde que cada vez que el proyector o pizarrón interactivo se mueve debe orientar el 
pizarrón interactivo. Quien quiera que haya ajustado el pizarrón o proyector pudo haber 
conectado el pizarrón y proyector a otra computadora, otra buena razón para orientar.  
 
1 Presione y mantenga ambos botones de la 

bandeja hasta que la pantalla de orientación 
aparezca.  
  
 

2 Oriente su pizarrón interactivo al presionar 
firmemente en el centro de cada cruz en la 
secuencia indicada.  
  
  
  
  
  
  
 

Probando la Funcionalidad Básica 
Con todos los cambios, es una buena idea probar la funcionalidad básica. Esto asegurará que 
todas la aplicaciones que estará usando para impartir la lección o presentación estén trabajando 
apropiadamente. 
 
1 Presione dos veces el icono del buscador de Internet (e.g., Internet Explorer). 

 
2 Presione el botón “Keyboard” de la bandeja. 

 

3 Presione una vez dentro de la barra de 
direcciones de su buscador de Internet. 

Botón 
Keyboard 

Botones de la  
Bandeja 
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4 Usando el teclado en pantalla, teclee www.google.com. 

  
 

5 Presione el botón Go junto a la barra de dirección de su buscador de Internet.  
 
 
 

6 Ustedo sabe que estará escribiendo notas directamente 
sobre la página web de Google™ durante su lección o 
presentación para poder resaltar puntos clave. Use una 
pluma de la bandeja para encerrar en un círculo el botón 
Back. 

 
 
 
7 Devuelva la pluma a la bandeja y toque la pantalla una vez para borrar el desaparecer el 

círculo que acaba de hacer. Presione “Click here to restore writing” en 
la parte inferior derecha de su pantalla para reaparecer el círculo. Ahora 
sabe que si toca la pantalla por accidente mientras tiene notas 
importantes en el pizarrón interactivo, será capaz de recuperarlas.  

 
8 Asegúrese que podrá guardar  cualquier información importante que 

querrá compartir an una lección o presentación futura. Presione el botón 
Area Capture, y después trace un contorno alrededor del circulo que 
dibujo sobre el botón Back de su explorador de Internet.   
 
NOTA: Notebook abrirá automáticamente, y sus notas y fondo se guardarán en una nueva 
página de Notebook. 
 

9 Toque la pantalla una vez para borrar el círculo del botón Back de su explorador. 
 
 

10 Presione el ícono de Notebook en la barra de tareas para ver 
lo que acaba de capturar en Notebook.  
 

11 Sálgase de Notebook; no hay necesidad de guardar su archivo Notebook. 
 
 
¡Felicidades! Usted ha completado la seccion de Funcionalidad Básica del Cuaderno de Trabajo 
del Estudiante del Pizarrón Interactivo SMART Board.
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Ink Aware 
 
 
 
 
 
 
 

Ink Aware  

¿Qué es Ink Aware? 
 
 
Cuando un programa es Ink Aware usted puede escribir y crear dibujos en un archivo 
activo. Por ejemplo, si escribe una nota o dibuja algo mientras utiliza Microsoft® Word, 
usted puede guardar su archivo en Word y sus notas serán visbles la próxima vez que 
abra su archivo. 
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¿Cómo funcionan las aplicaciones Ink Aware?  
Las aplicaciones Ink Aware reconocen qué área del programa es el área activa de trabajo y qué 
área es usada para botones y barras de herramientas. 
 

 
 
 
 

¿Qué aplicaciones son Ink Aware? 
Existen más de una docena de aplicaciones Ink Aware, tal como podemos ver en la tabla a 
continuación.  
 

Microsoft  
Office 

Microsoft Word, Microsoft Excel, PowerPoint® 

Aplicaciones 
Gráficas 

CorelDraw®, Microsoft Imaging, Corel Grafigo™, Microsoft Paint 

Aplicaciones para 
Presentaciones 

PowerPoint, Corel Presentations™, Microsoft NetMeeting® 

Otras Aplicaciones 
AutoCAD®, VoloView Express™, AutoVue™ Professional, Microsoft 
Windows Journal, Microsoft Visio®, Adobe® Acrobat® 

 
Esta sección se enfocará en las Aplicaciones más utilizadas – Microsoft Word, Microsoft Excel y 
PowerPoint. 

} 
Botones y Barras de 
Herramientas 

Área de Trabajo Activa 

} 
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Microsoft Word 
Cuando utilice Microsoft Word con su pizarrón interactivo SMART Board se percatará de tres 
botones; usualmente son integrados a la barra de herramientas de Word, o pueden estar 
separados en una barra de herramientas flotante.   
 
 
 
          
 
 
 
 
 
 
 

 
 

 
 

 
 

 
 
 

Ejemplo: Presionando Insert como botón de imagen 

Antes de presionar el botón, la imagen no es 
parte del archivo de Microsoft Word. Sólo puede 
ser vista en el pizarrón interactivo. 

Presione el botón y la imagen se vuelve parte 
del archivo de Microsoft Word. Ahora, puede 
enviar sugerencias de cambios a la persona 
apropiada.  

 

Integrado a la Barra de 
 herramientas de Word 

Barra de herramientas  
flotante 

1 2 3 

1 2 3 

Presione este botón para insertar notas como una imagen directamente a su 
documento de Microsoft Word. 
 
 
Presione este botón para convertir su manuscrita o impresión a texto tecleado 
directamente en su documento de Microsoft Word. Sus palabras aparecerán en el 
punto del cursor en el mismo color en que fueron escritas.  
 
 
Presione este botón para capturar una imagen de la pantalla en Notebook. Notebook 
se verá en la siguiente sección del Cuaderno de Trabajo.  
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Microsoft Excel 
Cuando usa Microsoft Excel con su pizarrón interactivo se percatará de tres botones; usualmente 
son integrados a la barra de herramientas, o pueden estar separados en una barra de 
herramientas flotante  
 
 
 
          
 
 
 
 
 
 
 
 

 
 

 
 

 
 

 
 
 

Ejemplo: Presionando Insert como botón de texto 

Antes de presionar el botón, la imagen no es 
parte del archivo de Excel. 

Después de presionar el botón, la imagen se 
convierte en texto y aparece en la celda 
correcta. 

  

 

1 2 3 

1 2 3 

Presione este botón para insertar  sus notas cómo una imagen directamente 
a su documento de Microsoft Excel. 
 
 
Presione  este botón para convertir su manuscrita o impresión en texto 
tecleado directamente en la celda activa.  
 
 
Presione este botón para capturar una imagen de la pantalla en Notebook. 
Notebook se verá en la siguiente sección del Cuaderno de Trabajo.  

Integrado a la Barra de 
 Herramientas de Excel 

Barra de herramientas  
flotante 
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PowerPoint 
Es fácil presentar con PowerPoint en su pizarrón interactivo SMART Board. Navegue a través de 
su presentación, guarde sus notas y gane acceso a herramientas adicionales – todo con la barra 
de herramientas Slide Show. La barra de herramientas Slide Show aparece automáticamente 
cuando ejecuta una presentación. 
 

 

 
 

 
 
 

 
 

 
CONSEJO:  
Puede ir a la siguiente diapositiva de una presentación de PowerPoint al presionar dos veces el 
pizarrón interactivo, haciendo la segunda presión a la derecha de la primera. Para ir a la 
diapositiva anterior haga la segunda presión a la izquierda de la primera.  
 

El Menú Command  
Presione el botón central de la barra de herramientas Slide Show para ejecutar el menú 
Command.  
 
 
 
 

  

Barra de Herramientas 
“Slide Show” 

Ir a la página previa de su 
presentación 

Ir a la siguiente página de su 
presentación 

Abrir el menú Command 

Capture una imagen de la 
diapositiva actual  en Notebok Guarde sus notas directo 

en su presentación de 
Powerpoint 

Elimine sus notas de la página 

Finalice la presentación 

Ejecute el submenú de 
commandos de PowerPoint 
Commands  

Ejecute la barra de herramientas de 
Herramientas Flotantes 

Ejecuta el submenú de 
ajustes 
predeterminados 

Agregue una dispositiva a 
su presentación 



Ink Aware 

 18

Submenú de Comandos PowerPoint 

  
 
 
 
CONSEJO:  
Use el Command  Black/Unblack Screen cuando quiera llamar la atención de su clase o 
auditorio para alejarlos de la presentación y del expositor. Presione dos veces rápidamente en 
cualquier parte de la pantalla para volver a la diapositiva en la que se quedó.    

SMART Floating Tools 
Seleccione SMART Floating Tools para ejecutar la barra de herramientas Flotantes. 

 

Submenú Settings 

  

Salte a cualquier diapositiva de 
su presentación 

Haga negra su pantalla 

Imprima la diapositiva actual en su 
impesora predeterminada 

Abra la presentación de 
diapositivas de Powerpoint 

Deseleccione Save Drawing 
at End of Show si no quiere 
ser recordado de guardar sus 
notas. 

Deseleccione Transparent 
Toolbar si quiere que la barra 
de herramientas sea opaca. 

Deseleccione Double-Press to 
Advance para avanzar 
diapositivas con un solo toque. 
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Tabla resumen de herramientas Ink Aware 

Aplicaciones 
Herramienta Función 

Word Excel Power 
Point 

 
Inserta notas como un objeto en el 
documento u hoja de cálculo     

 

Convierte notas en texto tecleado y las 
inserta en un documento u hoja de 
cálculo 

   

 
Captura el área de trabajo activa visible 
en Notebook    

 

Abre el menú Command que le permite  
capturar y guardar sus notas, así como 
cambiar varios ajustes                                 
predeterminados 

   

 

Mueve su presentación de PowerPoint 
una diapositiva hacia adelante    

 

Mueve su presentación de PowerPoint 
una diapositiva hacia atrás    

 

CONSEJOS: 
1 Use los botones de la barra de herramientas Ink Aware para convertir sus notas directamente a 

Microsoft Word y Excel. 
2 La barra de herramientas Slide Show en PowerPoint le permite controlar una presentación mientras 

está en su pizarrón interactivo SMART Board.  
3 Puede ejecutar la barra de herramientas Floating Tools durante una presentación de diapositivas al 

seleccionar Slide Show Toolbar > Command  Menu > SMART Floating Tools. 
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Repaso: Aplicaciones SMART Ink Aware  

1 Describa la función de cada botón de la barra de herramientas Ink Aware que aparece en 
Microsoft Word. 

•  
 
 
 

•  
 
 
 
 

•  

 

 

2 Describa cómo insertar tinta digital como texto en una celda seleccionada de una hoja de 
cálculo de Excel. 

 

 

 

 

3 Describa cómo guardar escritura de una diapositiva de PowerPoint en Notebook. 

 

 

 

 

4 Describa cómo salvaría sus notas y dibujos a archivos de PowerPoint. 
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Repaso: Aplicaciones SMART Ink Aware 

1 La barra de herramientas Ink Aware tiene los botones Insert as Image, Insert as Text y 
Capture to Notebook. 

2 Para guardar tinta digital como texto, presione el botón Insert as Text en la barra de 
herramientas Ink Aware o en la barra de herramientas SMART. 

3 Presione al botón central de la barra de herramientas de tres botones Slide Show y seleccione 
Capture to Notebook. Tanto la diapositiva como las notas serán capturadas en Notebook. 

4 Presione al botón central de la barra de herramentas de tres botones Slide Show y seleccione 
Insert Drawing as Image.   
 
Si no guarda sus notas y sigue adelante a la siguiente diapositiva, se le preguntará al final de 
las diapositivas si quiere guardar sus notas, a menos que deseleccione esta opción del 
submenú Settings.  
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Práctica: Ink Aware y Microsoft Word en el Salón de Clase 

Preparación 
Para completar esta actividad de la práctica va a crear una pequeña trivia de dos preguntas. En 
un ejemplo real abrirá una trivia que ya tiene preparada de antemano.   
 
1 Abra Microsoft word. 

 
2 Usando el teclado de su computadora, teclee 13 x 7= y presione la tecla Enter 12 veces para 

dar al estudiante espacio para mostrar su trabajo. 
 

3 Usando el teclado de su computadora, teclee Complete la phrase siguiente con quien o 
quienes.  Presione la tecla Enter dos veces y teclee Ahorra es la hora para todos hombres 
buenos a asistir a ….  

Usando Ink Aware en el Salón de Clase 
Su clase acaba de completar la trivia que creó en Microsoft Word y querrá pasar a las respuestas 
en grupo. Usando la trivia de dos preguntas que ha creado, ya está listo para completar el 
tutorial.  
 
1 Usted quiere enseñar a su clase cómo mostrar mejor su trabajo al responder una pregunta 

de multiplicación. En el espacio provisto, muestre la mejor manera de llegar al resultado. 

  

2 Usted presiona el botón Insert as Image  para agregar su respuesta a un archivo de 
Word 

 
3 Pase a la seguda pregunta y explique a su clase cuándo debe usar la palabra quien y 

cuándo debe usar quienes, toque el pizarrón para colocar el cursor al final de la frase y 
escribir la respuesta conrrecta en el pizarrón.  
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4 Presione el botón Insert as Text   para convertir la respuesta correcta como texto al 
final de la oración. El texto aparecerá del mismo color de la tinta electrónica con que fue 
escrito. 
 

Ahorra es la hora para todos hombres buenos a asistir a quien? 
 
 
5 Guarda su documento de Word con un nuevo nombre para así poderlo enviar por correo 

electrónico o imprimirlo y distribuir copias de las respuestas a sus alumnos.  
 

¡Felicidades! Ha completado la práctica de Ink Aware y Microsoft Word en el Salón de Clase. 
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Práctica: Ink Aware y Microsoft Excel en la Oficina 

Preparación 
Para poder completar este ejemplo necesitará crear una hoja de calculo muestra de Microsoft 
Excel. En un ejemplo real podría utilizar una hoja de cálculo ya existente.  
 
1 Abra Excel.  

 
2 Usando el teclado de su computadora, teclee 

“Hotel” en la celda A2. 
 

3 Teclee “Flight” en la celda A3. 
 

4 Teclee “1000” en la celda B3. 
 

Utilizando Ink Aware en la Oficina 
Asumamos que atenderá a una conferencia con un grupo de colegas. Como grupo, han 
preparado una solicitud de viaje y están alistándose para presentarla a la persona que autoriza el 
gasto. 
 
1 Alguien declara que el hotel costará $150.00 por noche. Presione la celda B2 para resaltarlo, 

tome una pluma y escriba 150 en el pizarrón interactivo. 
 

 
 

2 Alguien más comenta que la tarifa corporativa es únicamente de $115.00. Coloque la pluma 
de nuevo en a bandeja y presione una vez el pizarrón para borrar su nota. Ahora, escriba 
“115” en el pizarrón.  
 

 
 

3 Presione el botón Insert as Text  para agregar a tarifa del hotel en la celda correcta. 
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4 El líder de su equipo demanda que se tengan cuando menos tres cotizaciones del vuelo. 
Encierre en un círculo el costo del vuelo, celda B3, y escriba “Get Quote.” 

 
 

5 El coordinador del viaje trata con un agente de viajes quien provee tres cotizaciones de 
aerolíneas diferentes con sólo una llamada. Presione el botón Insert as Image . 
 

6 Guarda su archivo de Excel para que el coordinador del viaje pueda ver sus notas cuando le 
envíe por correo electrónico el archivo, y le pida que consiga la cotización que necesita.  

 
¡Felicidades! Ha completado la Práctica Ink Aware y Microsoft Excel en la Oficina. 
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Práctica: Ink Aware y PowerPoint 
Esta actividad le dará una oportunidad de practicar utilizando PowerPoint en su pizarrón 
interactivo SMART Board. Necesitará utilizar su propio archivo de PowerPoint para completar la 
siguiente actividad.  

Pasos 

1 Abra cualquier archivo de PowerPoint. Si desea, seleccione File > Save As y guarde una 
copia del archivo con otro nombre para no cambiar inintencionalmente su trabajo mientras 
completa el tutorial.  

2 Seleccione View > Slide Show para comenzar su presentación de diapositvas. 
 

3 Presione el botón Next Page para moverse hacia adelante a través de la presentación.. 

 

 

 

4 Use el botón Previous Page para regresar al inicio de su presentación 

.  
 
 
 

5 Use los botones de navegación para ir a una diapositiva que contenga infomación que desee 
resaltar. Cualquier diapositiva será suficiente para ganar práctica usando PowerPoint con su 
pizarrón interactivo SMART Board.  

6 Tome una pluma y escriba “Nota Importante.” 

7 Devuelva la pluma a su ranura y presione en cualquier parte de la diapositiva de PowerPoint 
para limpiar la nota. 

8 Presione el botón central de la barra de herramientas Slide Show y seleccione Restore 
Drawing. Esta es una buena forma de traer de vuelta notas que han sido accidentalmente 
borradas. 
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14 Pretenda que no quiere cambiar permentemente su archivo de PowerPoint, pero quiere 
mantener la nota porque contiene un importante número telefónico. Presione el botón central  
de la barra de herramientas Slide Show toolbar y seleccione Capture to Notebook.  
 

                                      
 

NOTA: Notebook abrirá automáticamente. 

15 Presione el botón central de la barra de herramiemtas Slide Show y seleccione End Show. 

16 Una opción para grabar su dibujo aparecerá. Seleccione No para asegurar que su 
presentación permanece sin cambios.  

17 Cierre PowerPoint. 

18 Presione el ícono de Notebook de la barra de tareas para ver la nota importante que hizo. 
 

 
 

19 Podría salvar el archivo de Notebook file y tomar las acciones apropiadas en cuanto a la nota 
que escribió cuando el tiempo lo permita. No hay necesidad de salvar el archivo para 
completar este tutorial; cierre Notebook.  

 
NOTA: Notebook es cubierto a fondo en la siguiete sección. 

 
¡Felicidades! Ha completado la práctica Ink Aware y PowerPoint. 
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Notebook Software 
SMART Notebook¿Qué es Notebook? 

 
 
Usted puede utilizar notebook para crear una presentación llena de coloridas imágenes 
de clip art, Macromedia® Flash® objetos, gráficas y texto de una variedad de fuentes. 
Mientras presente, mantenga la atención de su auditorio moviendo e interactuado con 
estos objetos. Mientras su aditorio le haga sugerecias y comentarios, escríbalos en una 
página de Notebook utilizando las plumas o botones de pluma en Notebook. 
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Utilizando Notebook por Primera Vez 
Presione el icono  en el Área de Notificación 
de Windows, en la parte inferior derecha de su 
pantalla, y seleccione Notebook.  
 
Un nuevo archivo de Notebook se abrirá. Cada 
archivo nuevo de Notebook contiene un área de 
trabajo que puede ser llenada con objetos – 
notas en manuscrita, texto tecleado, gráficas, 
clip art y archivos Macromedia Flash son 
ejemplos de objetos que pueden ser agregados 
a un archivo Notebook.  
 
Una característica clave de Notebook es que puede añadir tantas páginas como necesite para 
capturar la información requerida. 

Barra de Herramientas de Notebook 
La barra de herramientas de Notebook le da acceso a numerosas herramientas para trabajar con 
su archivo de Notebook. Predeterminadamente, la barra de herramientas aparece en la parte 
superior de la página de Notebook. Si prefiere sentarse, o si está trabajando con estudiantes 
jóvenes, podría serle más conveniente mover la barra de herramientas a la parte inferior de la 
pantalla. Para hacer esto, presione y mantenga cualquier área vacía en la barra de herramientas 
y arrástrela a la parte  inferior de la pantalla. 
 

 
 
Botón Use esta herramienta para… Botón Use esta herramienta para… 

 
Crear un nuevo archivo en blanco de 
Notebook  

Ejecuta la barra de herramientas Capture 
(descrita a continuación) 

 
Abrir un archivo de Notebook 

 
Selecciona cualquier objeto en la página 

 
Guardar su archivo 

 
Escribe o dibuja en una página de Notebook 
con la herramienta pluma 

 
Pegar objetos del portapapeles en un 
archivo de Notebook  

Escribe o dibuja en una página de Notebook 
con la herramienta pluma creativa 

 
Zoom 

 
Borra los trazos de pluma en una página de 
Notebook 

 
Deshacer la última acción realizada 

 
Dibuja una línea 

 
Rehacer la última acción realizada 

 
Crea una forma 

 
Eliminar los objetos seleccionados 

 
Crea un cuadro de entrada de texto para 
teclear en una página de Notebook 

 
Mostrar la página de Notebook previa 

 
Establece el color actual de una 
herramienta, forma u objeto 

 
Mostrar la página de Notebook siguiente 

 
Selecciona el ancho de una línea de una 
herramienta u objeto seleccionado 

 
Inserta una página en blanco 
inmediatamente después de la página 
activa 

 
Establece la transparencia de una 
herramienta u objeto seleccionado 

 
Muestra/Esconde la sombra de la pantalla 

 
Selecciona las propiedades de línea de una 
herramienta u objeto seleccionado 

 
Ejecuta la vista de pantalla completa   
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Menús  
Los menús de Notebook dan acceso a las mismas herramientas y características encontradas en 
la barra de herraientas Notebook, así como a ciertas herramientas no disponibles en la barra de 
herramientas. Por ejemplo, el menú File le permite exportar su archivo como un PDF.  
 

Elemento de Menú Funciones 

File • Abre archivos nuevos o existentes 
• Guarda el archivo 
• Guarda la página actual como plantilla 
• Exporta el contenido a una variedad de formatos de archivo 
• Envía archivo a destinatario de correo 
• Imprime archivos o modifica ajuste de impresión 

Edit • Deshace y rehace acciones previas 
• Clona, corta, copia, pega o elimina objetos seleccionados o 

todos los objetos en la página 
• Edita texto 
• Revisa otrografía de todo el texto en el archivo 
• Elimina la pagina actual 

View • Cambia la vista actual (Page Sorter, Gallery, Attachments o Full 
Screen)  

• Esconde la barra de desplazamiento lateral 
• Ejecuta Screen Capture o Screen Shade tools 
• Zoom para agrandar o reducir su vista del contenido de la página 

Insert • Añade página(s) en blanco, plantillas, clip art, archivos de 
gráfico, archivos de Macromedia Flash o hiperlinks 

Format • Cambia propiedades de la fuente (negritas, subrayado, cursiva) 
• Cambia propiedades de objetos (color, ancho de línea, llenado, 

transparencia) 
• Bloquea propiedades y posición de objetos  
• Cambia el color de fondo de la página 

Draw • Crea formas, líneas y texto 
• Accesso a Pluma, Pluma Creativa y herramientas de Borrado 
• Selecciona, reordena, agrupa o desagrupa objetos 

Help • Accesso a información acerca Notebook 
• Revisa actualizaciones del programa 
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Fichas Laterales 
Hay tres fichas del lado derecho de la interfaz de Notebook. La ficha Page Sorter le permite ver 
vistas en miniatura de cada página en su archivo de Notebook. Presione la ficha Gallery para 
selección de plantillas, clip art y animaciones Flash para agragar a su archivo de Notebook. 
Presione la ficha Attachments para agregar adjuntos de otras aplicaciones a su archivo. Puede 
esconder la información de las fichas de la vista cuando haya terminado de utilizarla al 
seleccionar  en la parte inferior de las fichas. 
 

  

Vistas en 
Miniatura 

Fichas 

Presione para mover las 
fichas al otro lado de la 
página 
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Page Sorter (Clasificador de Páginas) 
Seleccione la ficha Page Sorter para ver las vistas   
en miniatura de todas las páginas de su archivo.  
Usted puede arrastrar una página a cualquier parte de 
la columna para cambiar el orden en su archivo.  
  
La página activa está incicada por un menú. Seleccionar otra 
página en la ficha Page Sorter hace de esa página la nueva  
página activa en Page Sorter y en el pizarrón. 

Menú Plegable de Page Sorter  
Seleccionar dicho menú en la página activa le presenta 
cinco opciones. 
 
 
 
 
 

Elemento de Menú Función 

Delete Page • Elimina la página actual 

Clear Page • Borra todos los objetos de la página actual 

Insert Blank Page • Agrega una página en blanco inmediatamente después de la 
página activa 

Clone Page • Crea una página idéntica, incluyendo todos los objetos en la 
página, y la inserta inmediatamente después de la página activa. 

Rename Page • Le permite renombrar su página 

 
Objetos en Notebook 
Cualquier cosa que pueda tocar, con su dedo o con el Mouse, dentro del área del pizarrón de 
una página de Notebook es un objeto. Usted puede agregar un objeto a una página de Notebook 
usando cualquiera de los siguientes métodos: 
 

• Tecleando texto  
 

• Dibujando o escribiendo en el pizarrón con una pluma de la bandeja 
 

• Creando figuras geométricas con la barra de herramientas de dibujo 
 

• Insertando un dibujo de la Galería, de su computadora o de Internet 
 
 

Página Activa 

Menú 

Nombre de la 
Página 

Número de  
Página 
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Modificado y Moviendo Objetos 
Seleccione cualquier objeto de su página de 
Notebook para cambiar sus características. Los 
objetos seleccionados tienen dos manijas y un 
menú. Use la manija verde para rotar el obteto y 
la blanca para hacerlo más chico o más grande.   
 
Para mover un objeto de una página a otra 
asegúrese que la estaña Page Sorter estpa 
activa y la casilla Auto-hide  no esté 
seleccionada. Entonces, simplemente seleccione 
el objeto que desea mover y arrástrelo a la página apropiada.  
 

 

Menú del Objeto 
 

                              

Seleccione un 
objeto y arrástrelo 
a una página 
nueva 

Hace una copia exacta del objeto y lo inserta 
en la página activa 

Seleccione para cortar, 
copiar, pegar o eliminar 
un objeto 

Seleccione para asegurarse que no se 
podran hacer cambios al objeto 

Seleccione de nuevo y presione   
para la opción de desbloquearlo 

Seleccione 
para revisar la 
ortografía de 
objetos de 
texto 

} 

Arrastre en sentido 
horario o al revés 
para rotar el objeto

Presione para ver 
el menú 
desplegable 

Arrastre  
diagonalmente para 
reajustar el tamaño 
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Agrupamiento 
Seleccione dos o más objetos presionando y arrastrando con su dedo o con el Mouse 
diagonalmente de lat modo que los objetos queden encerrados en un recuardo. Despliegue el 
menú de cualquiera de los objetos y seleccione Grouping > Group. 
 

 
 
Seleccione de nuevo el objeto agrupado y elija Grouping > Ungroup para separar los objetos. 
Esta función también descompone la manuscrita en trazos individuales.  

Orden 
Puede cambiar el orden en que los objetos aparecen al seleccionar Order del menú. 
 
Para reordenar un objeto una capa a la vez, utilice los comando Bring Forward (enviar al 
frente) o Send Backward (enviar atrás) . Para traer un objeto directamente a la capa superior 
utilice el comando Bring to Front. Para enviar un objeto a la útlima capa, use el comando Send 
to Back.  
 

 
 
 
 
 
 
 
 

 
 

Cuatro objetos acomodados de distinta manera 
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Hiperlink 
Seleccione Hiperlink del menú desplegable del objeto y un cuadro de dialogo aparecerá. Ingrese 
la dirección de una página web que desee vincular y presione OK.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
El ícono de una flecha aparecerá  en la esquina inferior izquierda del objeto. Seleccionar este 
ícono ejecuta el navegador de Internet y le devuelve la página vinculada.  
 
 
 
 
 
 
 
Para quitar el Hiperlink , seleccione Hiperlink  denuevo del menú, presione Remove Hiperlink, y 
presione OK.   

Propiedades 
Seleccione propiedades del menú para cambiar el color, propiedades de líneas y transparencia 
de un objeto.  
 
 
  
 

Presione para ir a la 
página vinculada 
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Reconocimento de Manuscrita 
Si escribe algo con una pluma, tiene la opción de hacer reconocida su manuscrita y convertida a 
texto. 

     
 
Presione dos veces el texto y la barra de herramientas de la fuente aparecerá. Resalte el texto 
que quiera cambiar, y luego utilice la barra de herramientas para cambiar sus propiedades.  
 

 
 

Herramientas de dibujo  
Use las herramientas de dibujo deNotebook para crear sus propios objetos.  

Plumas 
Seleccione ya sea Pen o Creative Pen de la barra de herramentas y dibuje un objeto a mano 
libre.  
 
Escoja una variedad de estilos de líneas y colores al presionar la flecha junto a las herramientas 
Pen o Creative Pen.   

 

                                              
 
 

Líneas 
Presione el botón  de la barrra de herramientas de Notebook para dibujar líneas rectas. 
Seleccione cualquier línea hecha con esta herramienta y arrastre sus puntas para alargarla o 
cambiar su ángulo.  

                                                            
 
CONSEJO:  
Mantenga presionada la tecla Shift mientras rota una línea y la posicionará de 45° en 45°.  

Presione dos veces el texto para modificar sus propiedades 

Presione para cambiar estilos de líneas y colores 

Arrastre 
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Formas  
Cree rápidas figuras geométricas y realce cualquier actividad con la 
herramienta Shape de la barra de herramientas de Notebook.  

Crear una figura 

1 Presione la flecha junto al botón   de la barra de herramientas de 
Notebook y un menú con varias formas aparecerá.  

2 Seleccione la figura que desee usar y coloque el cursor en la página en 
donde quiere que la figura aparezca.  

3 Presione y arrastre hasta que la figura tenga el tamaño deseado.  
 
Una vez que la figura esté en su página de Notebook aún puede ser 
modificada del mismo modo en que modifica otros objetos, usando la manija 
de rotación, la de reajuste de tamaño y el menú.  

 
 

CONSEJO:  
Para facilitar la selección de una figura, seleccione el contorno, elija 
Properties del menú y rellene la figura con color.  
 

Personalizando las herramientas de Dibujo 
Cada una de las herramientas de dibujo tiene un menú. Presione la flecha 
junto a la herramienta que elija para seleccionar una opción de dibujo ya 
existente o para personalizar una con sus necesidades.  

 
  
 

Presione la flecha junto a 
la herramienta de dibujo y 
seleccione una opción ya 
existente 

Seleccione Customize para 
modificar la herramienta de 
dibujo segun sus 
necesidades 

Los puntos junto a cada 
línea significan el grosor 
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Insertando Imágenes en Notebook 
Para agrager una imagen a su archivo de Notebook puede hacer lo siguiente: 

• Use las herramientas Screen Capture para capturar imágenes que estén en su pantalla 
• Use el menú Insert para importar imágenes o clip art  de algún otro lugar de su 

computadora 

Barra de herramientas Screen Capture  
La barra de herramientas Screen Capture la permite capturar la imagen de 
una pantalla completa, una ventana o una porción de pantalla en una página 
de Notebook. Para acceder a la barra de herramientas Screen Capture, 
presione el botón Capture  de la barra de herramientas de Notebook.  
 
NOTA: Cuando esté seleccionada la opción Save to new page, cada imagen 
se guardará en una nueva página. De lo contrario, cada imagen se guardará 
en la esquina superior izquierda de la página de Notebook activa.  
 
 

Botón Cómo es usado 

 
Area Capture 

Presione y arrastre para enmarcar el área que quiere capturar. Libere la presión una 
vez que se seleccione el área. 

 
Window Capture 

Presione dentro de la ventana que usted desea capturar. Libere la presión una vez 
que la ventana deseada aparezca como área tramada. 

 
Screen Capture 

Navegue a la pantalla que usted desea capturar y presione el botón para capturar la 
pantalla entera. 

Menu Insert 
Inserte un dibujo que existe como archivo e su 
disco duro o red seleccionando Insert > 
Picture/Template > From File… y siga las 
instrucciones en pantalla. 
 
 
 
 
 
Para inserter una imagen de un escaner vinculado a su computadora, siga los siguientes pasos: 

1 Seleccione: Insert > Picture from Scanner.  
El cuadro de dialogo Insert Scanned Picture se abrirá. 

2 Seleccione un escaner de la lista. 

3 Presione el botón Scan. 

4 Escanee su imagen y ajústela como la desea, siguiendo  

los pasos que vienen con su escaner. 

5 Cuando el escaneado haya concluido, cierre el cuadro de diálogo y regrese a Notebook.  
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Galerías 
Las Galerías le ayudan a realizar e impartir presentaciones con un rico detalle gráfico. Miles de 
imágenes, plantillas y archivos en Macromedia Flash son organizados en colecciones que le 
permitirán crear atractivas y reciclables lecciones y contenido de reuniones.  

Abrir una Galería 
Presione la ficha Gallery a un costado de su pantalla. 
 

  

 

Plantillas 
Las plantillas pueden ser usadas como un punto de inicio común para cada página de su 
presentación. Por ejemplo, una plantilla en blanco de calendario de una colección de Planeación 
puede ser utilizada para agendar actividades en los meses subsecuentes. También puede crear 
su propia plantilla con logos y gráficos para segurar que su organización o escuela está 
certificada.  

Use los íconos  y  
para expandir o 
contraer colecciones 
disponibles 

Select the Gallery 
collection best 
suited to your 
needs 

Puede reconocer una plantilla 
de nuna colección de galleria 
por la esquina superior 
derecha doblada

Presione el elemento 
que desee utilizar y 
arrástrelo al área de 
pizarrón de Notebok 
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Creando sus propias Plantillas 
Si utiliza un formato en particular seguido, puede guardarlo como una plantilla.   

Para guardarlo como plantilla siga los siguientes 
pasos: 
 
1 Una vez creada la página que piensa que usará 

de nuevo, seleccione File > Save Page as 
Template. 

2 El cuadro de diálogo Save As aparecerá. 
Seleccione el lugar en su computadora en donde 
guardará su plantilla. 

3 Nombre su plantilla en el campo File Name. 

4 Presione el botón Save. 

 
 
 

 

 

My Content – Creando su propia Galería de Colecciones: 
Desde el área de navegación en la ficha Gallery 
puede encontrar un área llamada My Content al 
final de las colecciones.   

Para crear su propia colección, siga los siguientes 
pasos: 
 
1 Seleccione My Content. 

 
2 Presione la flecha para menú hacia abajo. 
 
3 Seleccione Add New Subcategory. 

 
4 Seleccione una anueva categoria.  

 
5 Seleccione la flecha hacia abajo. 

 
6 Seleccione Rename. 

 
7 Renombre su nueva categoría y presione Enter. 
 
Agregue su contenido a su nueva colección arrastrando objetos directamente del pizarrón hacia 
su archivo de Notebook o usando el botón Add/Import                           . 
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Botón Add/Import  
Seleccionar el botón Add/Import en la Galería hará aparecer un menú desplegable.  
 

 
 

Para usar el botón Add/Import, siga estos pasos: 

1 Desde una galería que haya creado, seleccione .  
 

2 Seleccione Import Picture/Template File…. 
 

3 Busque el archivo que desee importar. 
 

4 Seleccione la imagen o plantilla. 
 

5 Presione el botón Open. 
 
NOTA: Las imágenes que han sido importadas desde fuera de Notebook tienen una opción 
adicional en el menú que se llama Set Picture Transparency…. Seleccione esta opción para 
hacer que el fondo de su imagen sea transparente. 

 
 

                                             
 

 

 

Seleccione para agregar una nueva 
subcategoría Seleccione para agregar la 

página activa a la colección 

Selecione para ejecutar una 
ventana que le ayudará a buscar 
por imáganes/plantillas,archivos 
Flash o Colecciones 

Abre el navegador de Internet 
para permitirle actualizar 
colecciones y agregar otras 
nuevas 

{ 

Antes de seleccionar Transparencia, 
se puede ver un cuadro blanco 
alrededor de la mano 

Después de ajustar la trasparencia, 
podemos ver que el cuadro blanco 
desaparece y puede ver la gráfica 
completa. 
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Macromedia Flash y Notebook  
Notebook le permite agregar contenido de Macromedia Flash a sus presentaciones de Notebook 
tan fácilmente como agregar una imagen. Una vez agragado el archivo Flash a su página de 
Notebook, puede interactuar tal y como si estuviera en un navegador de Interet. A diferencia de 
un navegador de Internet, Notebook le permite seleccionar, mover, agregar hiperlinks, y también 
rotar el contenido Flash de la página. 

Agrager contenido Flash de la Galería 
1 Abra la galería presionando dicha ficha. 

2 Navegue al contenido Flash que quiera agregar a su archivo. Un archivo Flash aparecerá ya 
sea como ícono o como vista en miniatura con un pequeño icono de Flash en la esquina 
superior izquierda: 
 

      

3 Arrastre el contenido Flash de la Galería hacia el área del pizarrón de la página de 
Notebook. 

Ficha Attachments  
Presione la ficha Attachments, directamente debajo de la ficha Gallery, para agregar o editar 
archivos, páginas Web e hiperlinks adjuntos a su archivo de Notebook.  
 

 
 
 

Para insertar un archivo seleccione Insert de la parte inferior de la ficha Attachments y busque 
por el lugar en donde está su archivo. Para abrir el archivo o el Hiperlink una vez que ha sido 
adjuntado al archivo de Notebook, simplemente haga doble presión en su nombre en la ficha 
Attachments.  

Compartiendo su archivo de Notebook 
Hay varias formas de compartir su archivo de Notebook con sus colegas. La más facil es guardar 
su archivo– seleccione File > Save – y permitirles usarlo. También puede crear una copia de su 
archivo para otros usuarios seleccionando File > Save As. Estos métodos sólo funcionarán si 
sus colaboradores tienen Notebook instalado en sus computadoras, y están en la misma red que 
usted. Aún puede compartir su contenido con quienes no tienen Notebook instalado en sus 
computadoras utlizando los siguientes métodos: 
 

• Imprimir el contenido de su archivo de Notebook en papel 
• Exportar su archivo de Notebook a HTML, como PDF o como una seria de imágenes 

(e.g., JPEG, GIF, etc.) 
Enviarlo por correo electrónico en su formato original o en PDF  
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Imprimiendo el Contenido de Notebook 
Seleccione File > Print para imprimir el contenido de su archivo de Notebook. Un cuadro de 
diálogo de impresión aparecerá. Desde aquí puede definir sus preferencias de impresión, 
incluyendo la opción de imprimir seis diapositivas por hoja – esta es una excelente forma de 
entregar sus diapositivas a un gran grupo de gente y ahorrar papel.  

 
 

 
Exportando su arhivo Notebook 
Usted puede exportar su archivo de Notebook en una variedad de formatos digitales. Por 
ejemplo, puede exportar los contenidos como una serie de imágenes o como archivos HTML, o 
como archivos en PDF. La función Export  es útil cuando quiere compartir información con 
usuarios que no tienen Notebook instalado en sus computadoras. Seleccione File > Export, 
luego seleccione el formato del archivo a ser utilizado y presione OK. 
 
 

 
 

 
 

Select the printer 
you would like to 
use 

Preparar folletos 
para sus clases o 
reuniones 
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SMART Notebook Print Capture 
Print Capture le permite agregar 
archivos multi-páginas enteras 
desde otras aplicaciones, como 
Microsoft Word, PowerPoint o 
un navegador Web browser, a 
su archivo de Notebook activo.  
 
Print Capture es similar a 
imprimir en papel. Por cada 
página que normalmente 
aparecería en una pieza 
separada de papel, una nueva 
página de Notebook será 
creada.  
 
Abra el archivo que desee 
capturar en Notebook y 
seleccione File > Print – 
cualquier aplicación desde la 
que normalmente puede 
imprimir un trabajo funcionará.  
Cuando el cuadro de diálogo de 
impresión aparezca, seleccione 
SMART Notebook Print 
Capture de la lista de 
impresoras disponibles. 
Presione OK para imprimir 
hacia un archivo de Notebook.  
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Repaso: Software de Notebook  

1 Etiquete el control de rotación, el control de ajuste de tamaño y el menú deslizable del siguiente 
objeto. 

 
 
 

2 Describa cómo mover un objeto de la página de Notebook a otra.  
 
 
 
 

 

3 ¿Cómo accesa a la barra de herramientas Screen Capture?  
 
 
 
 

4 Si usted ve las gráficas siguientes en la colleccion de la galería de Notebook, ¿cuál sería la plantilla, 
cuál sería una pieza del clip art y cual sería un archivo de Macromedia Flash? 

 
 

                    
 
 
 

5 Describa cómo guardar  su archivo de Notebbok como un archivo PDF.  
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Respuestas: Software de Notebook  

1     

 
 

2 Arrastre un objeto desde el pizarrón a la miniature de la página dentro de la clasificadora de 
páginas deseada para poner el objeto.  

3 Para accesar la barra de herramientas Screen Capture (captura en pantalla), presione el botón 
Capture  en la barra de herramientas de Notebook.  

4  

                     
 
 

5 Seleccione File > Export > PDF para guarder un archivo de Notebook como un archivo PDF. 

 
 
 
 
 
 
 
 
 
 

Control de rotación 

Menú deslizable 

Control de ajuste de tamaño 

Archivo Flash  Plantilla Clip art 
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Práctica: Notebook en el salón de Clases 
 
Para esta actividad, usted creará una lección acerca de Norte América. Las mismas técnicas que 
use para esta lección pueden ser fácilmente usadas para crear otras lecciones de cualquier 
tema. 

Creando una Lección en 11 pasos: Comenzando 
1 Ejecute Notebook presionando el icono SMART 

Board  de la barra de tareas de Windows en 
la parte inferior derecha de su pantalla, luego 
seleccione Notebook. 
 

2 Seleccione la ficha Gallery y navegue a 
Education > Geography > Flags > North 
America. 
 

3 Encuentre las banderas de Estados Unidos, 
México y Canadá en la Galería y arrástrelas 
hacia el área del pizarrón.  
 

4 Seleccione cada una de las banderas 
individualmente y ajuste el tamaño usando el 
control de tamaño de tal modo que todas las 
banderas queden aproximadamente del mismo 
tamaño y puedan ser vistas en la misma página 
simultánemante. 
 

5 Ponga las banderas en línea horizontal.   
 
 
 
 
 
 
 
  

6 Escriba el nombre de cada país en un color diferente. Puede utilizar las plumas de la 
bandeja de pluma o la Herramienta Pluma  de la barra de herramientas Notebook. 
 
NOTA: si usted está creando esta lección en una computadora de escritorio, mecanografíe el 
nombre de cada país usando su teclado y siga al paso 8. 
 

7 Seleccione individualemente el 
nombre de cada país y reconozcalo 
como un texto mecanografiado 
unsando el menu deslizable. 
 
    
 

8 Utilice el comando Clone en el menu 
deslizable para hacer una copia del 
nombre de cada país.  

 
 
9 Ahora usted debe tener dos copias de 

los nombres de cada país. Organice los nombres de cada país para que el listado de 
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nombres se acomode verticalmente en una área libre de su pantalla. Con el Segundo grupo 
de nombres, arrastre el nombre de cada país a su bandera. 

 
 
10 Seleccione cada bandera. Usando el menú deslizable elija Order > Bring to Front – esto 

cubrirá los nombres de los países. 

 
 

Presione el botón Save (Guardar)  en la barra de Herramientas de Notebook. Si usted no ha 
guardado previamente su lección, nombre y elija un lugar donde pueda encontrarlo en un futuro 
más fácilmente. 

Cómo puedo utilizar esto? 
Pida a sus estudiantes que arrastren el nombre de cada país debajo de la bandera 
correspondiente. Cuando sus estudiantes completen el ejercicio, mueva las banderas para 
revelar la respuesta correcta. 
 
La teoría detrás de las técnicas utilizadas para crear esta lección servirán en la creación de una 
actividad de otro tema. En vez de utilizar una bandera usted puede crear una forma rellena de 
color para esconder la respuesta correcta.  

 

Creando una Lección: Técnicas avanzadas 
Crear su propia colección de Gallery (Galería) y usar plantillas le ayudará a enriquecer 
gráficamente, lecciones reutilizables rápida y fácilmente.  
 
Usando la lección que acaba de crear, siga estos 
pasos:  
 
1 Seleccione la ficha Gallery y navegue hacia My 

Content. 
 

2 Seleccione el menu deslizable y elija Add New 
Subcategory. 
 

3 Seleccione la nueva categoría que se agregó a 
la Galeria. Desde el menu deslizable elija 
Rename. Usando un teclado, mecanografíe 
“Country Lesson.” 

 
4 Arrastre cada bandera y nombre de país a su nueva colección en Gallery. 

  
NOTA: Su nueva colección en 
Gallery debe contener ahora 
una bandera y un nombre para 
cada país.  

 
5 Selecccione la ficha Page 

Sorter e inserte una página en 
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blanco presionando el icono de nueva página  en la barra de herramientas de Notebook. 
  

6 Del menu de Formas , seleccione el cuadrado, luego dibuje un cuadrado o rectángulo 
grande, en el lado izquierdo de su página. Después de dibujar el cuadrado, seleccione la 
herramienta Pointer  de la barra de herramientas de Notebook. Si usted desea, puede 
rellenar el cuadrado de algún color seleccionando el cuadrado y eligiendo Properties desde 
el menú deslizable. 
 

7 Al lado derecho de la página, escriba o mecanografíe Lenguaje Oficial:. Debajo de esto, 
escriba o mecanografíe Español, Inglés, Inglés y Francés. 
 

 
 
8 Seleccione la ficha Gallery y navegue al área de My Content. Presione el botón Add/Import  

 y elija Add Current Page to Gallery.  Convertir la página en una plantilla, 
hará los futuros pasos en esta actividad más fáciles.  
 

9 Arrastre la bandera mexicana a la esquina superior izquierda de la página actual. Arrastre la 
palabra México directamente debajo de la bandera. 
 

10 Arrastre la plantilla que creó en el paso 8 al área del pizarrón. Esto creará 
automáticamente una nueva página de Notebook. 

 
 
11 Arrastre la bandera canadiense y la palabra Canada a la esquina superior izquierda de su 

nueva pantalla.  
 
12 Repita los pasos 10 y 11, pero use la bandera de los Estados Unidos y el nombre Estados 

Unidos. 
 
13 Presione el icono Save (Guardar)  en la barra de herramientas de Notebook. 

 

 

¿Cómo puedo utilizar esto? 
Pida a su clase que arrastre el lenguaje oficial de cada país hacia el cuadrado o haga que 
dibujen una flecha desde el lenguaje hasta la bandera correspondiente usando la herramienta 
Line . Si usted desea, puede esconder la respuesta correcta detrás del cuadro o bandera.  

Template

Ejemplo de la página de México 
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Práctica: Notebook  en la Oficina 
Para esta actividad usted creará tanto una plantilla de reunión, como un diagrama causa-efecto 
(aka, capítulo de estructura de pez). 
 
1 Ejecute Notebook  presionando el icono   en la barra de herramientas de Windows en la 

esquina inferior derecha, luego seleccione Notebook. 
 

2 Podría usar una platilla estándar para ésta reunión y para todas las reuniones que tenga en 
el futuro. Desde el menú Shapes  seleccione el cuadrado y dibuje un rectángulo a lo largo 
de la parte inferior de su página.  
 

3 Seleccione la herramienta Pointer  desde la barra de 
herramientas Notebook. Presione sobre el borde del 
rectangulo que creó. Del menú deslizable, seleccione 
Properties. Cambie el Fill Color (Color de relleno) a 
azul. 
 
 
 
 
 
 
 

4 Presione el botón Capture  en la barra de 
heramientas de Notebook para ejecutar la barra de 
herramientas de Capture. Abra el sitio de Internet o 
Intranet de su compañía – para este ejercicio usted 
puede usar www.smarttech.com.   
  
NOTA: La barra de herramientas Capture aparecerá 
sobre su buscador de Internet. 
 
 

5 Presione el botón de Area Capture, luego presione y 
arrastre para bordear el logo de su compañía. Deje de 
presionar una vez que el área haya sido seleccionada.  

 
 

6 Regrese al archivo Notebook y verá que su logo está en una nueva página de Notebook. 
Arrástrela a la página en el Page Sorter donde usted creó el rectángulo.  
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NOTA: Si Page Sorter se cierra antes de que usted pueda arrastrar el logo a la página 
adecuada, asegúrese que la casilla de  no está seleccionada. 

7 Seleccione la página de Notebook con el rectángulo y el logo. Mueva el logo a la esquina 
inferior izquierda de la página para que quede sobre el rectángulo.  
 

8 Con el logo aún seleccionado, presione el menú deslizable y seleccione Set Picture 
Transparency. Una ventana de diálogo aparecerá. Presione OK para cambiar la 
transparencia de la imagen. 
 

 
 
 

 
 
 

9 Seleccione el rectángulo. Desde el menú deslizable seleccione Lock in Place.  
 

10 Seleccione el logo. Desde el menú deslizable seleccione Lock in Place. 
 

 
 

11 Usted sabe que su presentación será de más de una página, y usted usará esta plantilla en 
cada página. Seleccione la ficha y navegue a My Content. 
 

12 Seleccione el menú deslizable y elija Add New Subcategory. 
 

13 Seleccione la nueva categoría que ha sido agregada a Gallery. Desde el menú deslizable 
seleccione Rename. Utilizando un teclado, mecanografíe “Colección de la reunión.” 
 

Before 

After 
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14 Presione el botón  y elija Add Current Page to Gallery.  Esto hará más 
fáciles los siguientes pasos de esta actividad. Ahora usted ha creado su plantilla de 
presentación.  
 

15 Presione el botón de guardar  en la barra de herramientas de Notebook. Si usted no ha 
guardado previamente el archivo de su presentación, póngale un nombre y elija una 
ubicación donde lo encuentre fácilmente en el futuro. 

Cómo puedo utilizar esto? 
Usted puede usar este archivo cada vez que crea una presentación. Los siguientes pasos le 
mostrarán un ejemplo de cómo usar las herramientas de dibujo y su plantilla para crear un 
diagrama de causa-efecto. También serán mostradas otras formas en que un profesional puede 
utilizar Notebook.  
 
1 Mecanografíe Causa y Efecto en la primera página de su archivo de Notebook. Ajuste el 

tamaño y centre las palabras de modo que la página pueda actuar cómo su página de título.   
 

2 Desde su nueva colección de Gallery, arrastre la plantilla que acaba de crear al área del 
pizarrón de su archivo de Notebook. Esto creará automáticamente una nueva página. 

 
3 Usando la herramienta Line  en la barra de herramientas de Notebook, dibuje una linea 

horizontal y cuatro líneas conectoras como se muestra abajo.  

 
 

4 Utilizando la herramienta Shape  dibuje un círculo en la cabeza de la estructura del pez. 
Escriba el efecto del cuál está tratando de determinar la causa. Por ejemplo, el papeleo no 
fue completado a tiempo. Escriba las posibles causas y ubíquelas al final de cada línea. 
 

 
 

NOTA: Para seleccionar una línea después de 
que fue creada presione el botón Pointer   en 
la barra de herramientas de Notebook, luego 
seleccione la línea.  



Notebook 

 54

5 Presione el icono de guardar  en la barra de herramientas de Notebook. 
 

¡Cómo puedo utilizar esto? 
Cuando usted comienza su sesión para discutir porque el papeleo no fue completado, usted 
podrá empezar con una lluvia de ideas acerca de las posibles causas de su problema. Escriba 
las ideas de su sesión utilizando una pluma de la bandeja de plumas. 
 

 

 
Other ways to use Notebook  in the office:  

        
 
 
 

 

Flowcharts Strategic Management 

Notebook Gallery Templates 
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Herramientas 
SMART Board  
SMART Board Tools Porqué debería usar 
herramientas SMART 
Board? 
 
Las herramientas de SMART Board proveen un rápido acceso a las funciones que le 
ayudan a operar el pizarrón interactivo más efectivamente. Las herramientas de SMART 
Board también incluyen acceso a herramientas multimedia, que le permitirán crear y 
presentar contenido dinámico.   
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Acceso a las herramientas SMART Board 
Presione el icono SMART Board   en la barra de tareas de Windows, en la esquina inferior 
derecha de tu pantalla.  
 

 
 
 
NOTA: El  Notebook se cubre en detalle en la sección previa del Libro de trabajo del estudiante, el 
teclado en pantalla (On-Screen Keyboard)  y la función de orientación (Orient) se cubren en la 
sección de Funcionalidad básica. 

Grabadora SMART (SMART Recorder) 
Con la grabadora SMART usted puede hacer un archivo de 
video  de todo lo que hace en el pizarrón interactivo, sin 
importar las aplicaciones que utilice. Usted puede entonces 
reproducir la grabación en cualquier computadora con 
SMART Video Player o Windows Media Player 
(descárguelo gratis en www.windowsmedia.com/download).  
 
La interfase de tres botones , le permite controlar el proceso 
de grabación.

Abre el software Notebook 

Abre la grabadora SMART 

Abre la reproductora de video SMART 

Abre el Teclado en Pantalla 

Abre las herramientas flotantes 

Despliega el Centro de Inicio 

Acceso a las herramientas de Sombra de Pantalla, Reflector y Lupa 

Provee de una variedad de opciones de configuración de hardware y software   

Inicia el proceso de orientación 

Revisa las actualizaciónes del software vía Internet  

Abre el Centro de Ayuda del software SMART Board  

Cierra las Herramientas de SMART Board  

Record  Pause Stop 

Menú de herramientas de SMART Board 
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SMART Recorder (Grabadora SMART) – Menú 
desplegable del botón Record (Grabar)  
 
El menú desplegable del botón Record le permite 
elegir la región de su escritorio que será grabada. Si 
usted no elige que le gustaría grabar, el ajuste 
predeterminado grabará el escritorio completo.  
 

Grabar el escritorio : Graba todo lo 
que hace en el escritorio. 

  

 
 Grabar un Area: Elija el area de su pantalla que le gustaría grabar. 
  
 

Grabar una ventana: Elija una ventana que le gustaría grabar.  
0 
 

 
SMART Recorder  – Menu  
 

 

Cambia los ajustes de audio 
y video 

Abre el Centro de Ayuda  del 
software SMART Board  Transforma  el video del 

SMART Recorder a un 
archivo  reproducible en 
cualquier computadora 

Reduce el SMART Recorder en un 
icono en la Barra de Tareas de 
Windows. 

Obtenga información legal 
y técnica acerca del 
SMART Recorder 
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Optiones de Grabación  
Seleccione Options desde 
el Menu. Una ventana de 
diálogo aparecerá para 
permitirle controlar los 
ajustes de audio y video. 
Por ejemplo, usted puede 
grabar un video con o sin 
audio y cambiar el número 
de cuadros por segundo a 
grabar. 
 
SMART Recorder Video 
emplea un algoritmo que da 
como resultado archivos 
más pequeños pero que 
solo pueden ser 
reproducidos en 
computadoras que tengan 
el software SMART Board 
instalado. 
 
Seleccione la ficha Target 
Files para cambiar la 
ubicación destino de los 
archivos a guardar en su 
computadora. Seleccionando esta pestaña también tendrá la opción de establecer advertencias 
en caso de poco espacio de disco y la ubicación donde serán guardados los archivos 
temporales. 

 
SMART Video Player 
Escriba o dibuje sobre un video 
durante una presentación. Usted 
puede usar el SMART Video 
Player para reproducir archivos 
de video localizados en su 
computadora o ver contenido de 
una cámara, VCR, CD-ROM o 
DVD. SMART Video Player es 
compatible con la mayoría de las 
cámaras de video y cámara de 
documentos. 

Reproducir archivos de video 
Abra el SMART Video player 
desde el menu de herramientas 
SMART Board. Seleccione File > 
Open.  Busque el directorio 
apropiado y abra el archivo de 
video. Su video se reproducirá en 
la ventana del SMART Video 
Player. 



SMART Board Pizarrón Interactivo 
Libro de Trabajo para el Principiante 

 

 59

Controlando archivos de video 
Use la barra de herramientas de Control para reproducir, pausar y controlar el volumen de su 
video. Usted puede usarlo también para hacer notas y personalizar las notas y dibujos que serán 
presentados.  
 

 
 

 
Play/Pause: Reproduce o pausa la película   

 
Stop: Detiene la película y la regresa al inicio 

 
Image Capture: Captura  el cuadro actual en el  Notebook 

 
Cursor: Regresa el mouse a modo de cursor  

 
Pen: Usa el cursor como una herramienta de pluma 

 
Pen Color: Cambia el color de la pluma 

 
Line Width: Cambia el ancho de la pluma. 

 
Clear Screen: Borra cualquier nota escrita sobre el video 

 
Full Screen: Permite utilizar la pantalla completa para mostrar el video  

 
Mute: Detiene todo el sonido 

 
Volume Slider: Aumenta o disminuye el volumen 
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Escritura sobre video 
Usted puede escribir sobre un video, ya sea con una pluma de la bandeja de plumas o 
presionando el botón de la pluma. 

Pausar mientras se escribe 
El ajuste predeterminado para el Video Player 
obligue a pausar la reproducción en el momento 
que usted tome una herramienta de la bandeja 
de plumas. Si usted quiere que el video continué 
reproduciéndose aunque usted tome una pluma 
o borrador de la bandeja de plumas (o cuando 
utilice la pluma de la barra de herramientas del 
reproductor de video), haga lo siguiente:  
1 Seleccione Settings > Video Player 

Settings. 

2 Quite la selección en el cuadro de Pause 
when Tool(s) Lifted. 

3 Presione  OK. 

Desaparición gradual de las anotaciones  
Mientras el video se reproduce, tal vez desee que las notas desaparezcan sin tener que 
presionar el botón Clear Screen. Si es así, use la opción de Fade Out Annotations. Cuando 
seleccione esta opción su dibujo disminuirá gradualmente hasta desaparecer.   
 
Para habilitar/deshabilitar la opción de Fade Out Annotations haga lo siguiente: 
 
1 Seleccione Settings > Video Player Settings  

2 Seleccione o quite la selección en el cuadro de Fade Out Drawing.  

3 Designe la cantidad de tiempo (en segundos) que deben pasar antes de que la tinta empiece 
a desaparecer y cuanto tiempo debe pasar para que se limpie la pantalla.  

4 Presione OK. 

Control del tamaño de la pantalla de su video  
SMART Video Player incluye tres vistas: 100%, 200% y Pantalla Completa. Para controlar el 
tamaño de la vista de su video, seleccione el tamaño deseado del menú View. 
Si usted selecciona 100% o 200%, el video se reproduce en una ventana que incluye una barra 
de titulo, barra de menú, barra de herramientas y barra de estado. Sin embargo, la vista en 
pantalla completa usa el pizarrón interactivo o la pantalla completa, de modo que ni el menú, ni la 
barra de herramientas serán visibles.  
Cuando usted selecciona la vista en pantalla completa, una 
barra de herramientas distinta aparece con botones para 
reproducir y pausar el video, así como para capturar y borrar 
su escritura. Esta barra de herramientas también incluye un 
botón para regresar a la vista normal.  
Uso de dispositivos de entrada del Video  
Cuando usted conecta un dispositivo de video (Como VCR o cámara de video) a su sistema, 
SMART Video Player detecta el dispositivo y lo agrega al menú Hardware. Seleccione el 
dispositivo que quiere en el menú Hardware. 
 
 
 

La barra de herramientas en pantalla completa 
puede moverse a cualquier parte de la pantalla 
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Herramientas flotantes (Floating tools) 
Las Herramientas Flotantes realzan las opciones ya disponibles en la bandeja de plumas; 
las características que más use se encuentran literalmente en las yemas de sus dedos. 
 
 
Llame las Herramientas Flotantes desde el menú de herramientas SMART Board que aparece 
después de seleccionar el icono SMART Board en la esquina inferior derecha de su pantalla. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Botón Use ésta herramienta para… 

 
Capturar un área de la pantalla en el Notebook  

 
Dejar de usar otras herramientas y regresar el cursor al modo de  
mouse  

 
Escribir o dibujar en tinta digital  

 
Marcar un área en la pantalla con tinta traslucida para enfatizar sin 
escribir sobre un objeto 

 
Deshacer la acción previa. Esta herramienta guarda dos estados, 
Deshacer y Rehacer 

 
Rehacer una acción que borró por error. Este es el segundo de los 
dos estados mencionados arriba 

 
Borrar tinta digital 

 
Hacer de su siguiente toque sobre el pizarrón interactivo un clic 
derecho 

 
Abrir el menú deslizable para personalizar las funciones de la 
barra de herramientas  

 

Captura de Area 

Deshacer  

Borrador Más Clic 
derecho 

Minimizar/expandir barra 
de herramientas 

Marcador Cursor Herramienta de 
pluma 
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Personalización de las Herramientas Flotantes 
Presione el botón  More para cambiar las herramientas que 
serán mostradas en la barra de herramientas Floating Tools. 
El menú deslizable que aparece cuando presiona el botón 
More también le da la opción de cambiar el comportamiento 
de una herramienta que ya esté en la barra de herramientas 
Floating Tools. 

Agregar y quitar herramientas  

 
 
Para agregar una herramienta a la barra de herramientas Floating Tools haga lo siguiente: 
 
1 Seleccione Customize Floating Tools… desde el botón 

More del menú deslizable. 
2 Seleccione una herramienta del menú Available Tools. 
3 Presione el botón Add >>  
4 Presione OK. 
 
Para quitar una herramienta de la barra de Floating Tools haga lo siguiente:  
 
1 Seleccione Customize Floating Tools… del botón More en el menú deslizable. 
2 Seleccione una herramienta del menú Current Toolbar. 
3 Presione el botón << Remove. 
4 Presione OK. 
 
CONSEJO: 
Presione el botón Restore Default Toolbar… en la esquina inferior izquierda del cuadro de diálogo  
Customize Floating Tools para regresar la barra de herramientas flotantes al Classic Tool Set o el 
Creative Tool Set.  
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Start Center (Centro de inicio) 
Start Center es una barra de herramientas muy conveniente que le da acceso a las herramientas 
más utilizadas del pizarrón interactivo SMART Board.  Abre al Start Center presionando el icono 
SMART Board en la esquina inferior derecha de su pantalla y seleccione Start Center. 
 

 
 

 
CONSEJO: 
Usted también puede llamar al Start Center (Centro de Inicio) presionando dos veces el icono SMART 
Board  en la esquina inferior derecha de su pantalla. 
 

Abre el  reproductor de video 

Abre las herramientas 
flotantes 

Abre el Centro de ayuda de 
SMART Board  

Abre la grabadora SMART  

Abre el teclado en pantalla 

Abre el Panel de control 

Personaliza el centro de inicio 

Abre el software Notebook  
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Personalizando el Start Center (Centro de inicio) 
 

 
 
Para agregar una aplicación al Start Center complete los 
siguientes pasos:  
 
1 Presione el botón More y seleccione Customize Start 

Center…. 
2 Seleccione una aplicación desde el menú Available Tools. 
3 Presione el botón Add >>. 
4 Presione OK. 
 
Para quitar una aplicación del Start Center complete los siguientes pasos:  
 
1 Presione el botón More y seleccione Customize Start Center. 
2 Seleccione una aplicación desde el menú Current Toolbar. 
3 Presione el botón << Remove. 
4 Presione OK. 
 
CONSEJO: 
Presione el botón Restore Defaults de la esquina inferior izquierda de la ventana de diálogo Customize 
Start Center para regresar el Start Center a su configuración original. 
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Otras herramientas 
Abre a las herramientas adicionales SMART Board presionando el icono SMART Board en la 
esquina inferior derecha de su pantalla y seleccionando Other Tools, y luego elija la herramienta 
que desea utilizar. 

Screen Shade (Sombre de pantalla) 
Revele información gradualmente a su audiencia o clase con el Screen Shade. Recuerda usted 
cuando se utilizaba una hoja de papel para cubrir la información de un acetato en un proyector 
de acetatos?  El Screen Shade funciona de manera similar.  
 

 
 
Arrastre los controles en la dirección en que usted quiera reveler la información. 
 
CONSEJO: 
Presione dos veces Screen Shade para cubrir inmediatamente su pantalla de Nuevo, después de 
revelar parcialmente información. 

Spotlight (Reflector)  
El Spotlight es una buena forma de atraer la atención e un punto 
específico en su pantalla. El botón Menu le permite cambiar la 
forma y transparencia del reflector. El botón Menu también se 
utilize para cerrrar el reflector. 
 
Expanda o minimice el reflector presionando y arrastrando el 
borde azul. Mueva el reflector presionando en cualquier parte del 
area oscura de la pantalla y arrástrela al area de la pantalla donde 
quiere que su audiencia se enfoque. 
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Magnifier (Lupa) 
La herramienta Magnifier le permite aumentar el tamaño de cualquier parte de su pantalla para 
mostrar una vista más detallada de un área en particular.  
 
La herramienta Magnifier consiste en dos ventanas. La ventana más pequeña se utiliza para 
seleccionar el área de la pantalla que quiere aumentar – cómo por ejemplo, una dirección de 
Internet o una celda de una tabla que la gente sentada hasta atrás del salón no pueden ver bien. 
La ventana más grande muestra la vista aumentada de lo que usted quiso agrandar. 

 

Arrastre el borde del cuadro más grande para ajustar el tamaño del área a aumentar. 

 

Arrastre el borde para ajustar 
el tamaño  de ambas 
ventanas del Magnifier 
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Control Panel (Panel de control) 
 
El Control Panel de SMART Board es donde usted puede configurar varias opciones 
del software  y hardware para el producto interactivo SMART. Para abrir Control 
Panel, presione el icono SMART Board  localizado en la Barra de Tareas de 
Windows en la esquina inferior derecha de su pantalla y seleccione Control Panel. 

 

 
 

SMART Board Settings (Ajustes del SMART Board) 
La ventana de SMART Board Settings le permite revisar el estado de la conexión del 
pizarrón interactivo y conectar manualmente su producto si es necesario. Es también 
donde usted puede cambiar los ajustes del control de muestra, ajustar los dispositivos 
de salida del video y realizar otros procedimientos relacionados con hardware.  

 

         

Indica el estado del pizarrón 
interactivo 

Detalles de los 
productos 

Selecciona los 
ajustes de pantalla 
del menu deslizable 
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 Orient/Align the SMART Board (Orientar y alinear el SMART Board) 
Inicie el proceso de orientación presionando el Orient/Align the SMART Board. El 
proceso de orientación se cubre en detalle en la sección de Funcionalidad Básica de 
este libro de trabajo. 

SMART Board Connection Wizard  (Asistente de la conexión del SMART Board) 
Utilice el SMART Board Connection Wizard para conectar rápida y fácilmente su 
pizarrón interactivo a su computadora y ajustar la imagen proyectada en la superficie 
del pizarrón interactivo. 

 

 
 

 

 

 

Ajustes de Pluma y Botones 
Modifique las propiedades de las herramientas de la bandeja de plumas utilizando la 
pantalla de Pen Tray Settings. Usted puede aumentar o disminuir el tamaño del 
borrador, y personalizar los ajustes en los botones de la bandeja de plumas. 
Presione el botón de la herramienta a la cuál quiere cambiar su configuración y un 

cuadro de diálogo para esa pantalla aparecerá. 

 

 
 

 

 

 

 

 

Presione para 
modificar la pluma 
correspondiente en la 
bandeja de plumas  

Presione para modificar 
los ajustes del borrador 

Presione para 
personalizar los 
botónes de la 
bandeja de plumas 
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Ajustes de la pluma 
Presione un botón de una pluma coloreada en la ventana de Pen Tray Settings 
para cambiar las propiedades de la pluma correspondiente. Utilice las paletas 
de la ventana Customize Tool y los menus deslizables para cambiar el color, 
largo, forma de terminación, y anchura y transparencia de una línea. 

 

 

 

 

 

 
 

 Anchura del borrador 
Cambie la anchura del borrador de la bandeja de plumas presionando el botón 
Eraser en la ventanade Pen Tray Settings y elija la anchura deseada de la 
ventana Customize Eraser. 
 

 

 

 
 

 Personalizando los ajustes de los botones 
Personalice las funciones de los botones de la bandeja de plumas presionando 
el botón Buttons en la ventana Pen Tray y eligiendo una acción para cada 
botón de los menús deslizables de Customize Buttons. 
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Ink Aware Application Settings (Ajustes de las aplicaciones Ink Aware)  
SMART Ink Aware trabaja en el fondo para integrar el SMART Board con otras 
aplicaciones, incluyendo la conocida presentación del tercer participante, 
procesamiento de datos y aplicaciones gráficas. Se puede deshabilitar Ink Aware para 
una aplicación o rehabilitarla si ha sido previamente deshabilitada, usando el recuadro 
vacío al lado del nombre en la lista de las aplicaciones Ink Aware. 

 
SMART Board Software Language Settings (Ajustes del lenguaje del software SMART 
Board) 

Seleccionar SMART Board Software Language Settings le permite instalar alguno de 
los tantos paquetes de lenguajes disponibles en el software SMART Board. Una vez 
que usted ha instalado paquetes adicionales de lenguaje, puede cambiar el lenguaje 
desde el menu deslizable de SMART Board Software Language Settings. 
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Mobile and Wireless Device Settings (Ajustes del dispositivo móvil y inalámbricos) 

Establezca un vínculo entre su dispositivo móvil, como una laptop y su pizarrón 
interactivo SMART Board interactive whiteboard presionando el botón Mobile and 
Device Settings y revisando el Start the Mobile Device Manager. Usted puede elegir 
comenzar el arranque del Mobile Device Manager de Windows y recibir un aviso 
antes de compartir su escritorio en el pizarrón interactivo.  

 
 
 
NOTA: Para establecer una conexión, ambas computadoras deben estar conectadas a la misma 
red. En el pizarrón interactivo o computadora destino debe estar corriendo el SMART Board 
version 9.x o posterior, con el Mobile and Wireless Device Settings habilitado. 
 
La computadora móvil (laptop) debe estar corriendo el software LinQ™. Descargue el software 
LinQ gratuitamente desde www.smarttech.com/support/software/linq.asp.  

 
About Software and Product Support (Acerca de la ayuda para software y producto) 

Presione el botón About Software and Product Support para aprender más acerca 
del  SMART Board, contactar al grupo de Soporte Tecnico de SMART, actualizar su 
software, registrar su pizarrón interactivo, realizar un diagnóstico, o entrar a la ayuda, 
entrenamiento y otros recursos. 
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Repaso: Herramientas Smart Board  

1 ¿Cómo puede abrir el menu de SMART Board Tools? 
 
 
 
 
 
 

2 ¿Cómo puede agregar o eliminar herramientas de la barra de herramientas Floating Tools? 
 
 
 
 
 
 

3 ¿Cuáles son las tres formas en que puede usted seleccionar el área de su pantalla que quiere 
grabar usando la SMART Recorder? 

•  
  

•  
  

•  
 
 
 
 

4 ¿Cómo abre las herramientas de Screen Shade (Sombra de pantalla), Magnifier (Lupa) o Spotlight 
(Reflector)? 
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Respuestas: Herramientas SMART Board  

1 Presione el icono SMART Board icon en la esquina inferior derecha de su pantalla.  
 

2 Presione el botón More en la barra de herramientas Floating Tools y seleccione una 
herramienta del menu  Available Tools y presione Add >> y después presione el botón  OK 
o también una herramienta del menú  Current Toolbar y presione << Remove y luego 
presione el botón OK. 
 

3 • Record Desktop (predeterminado) (Grabar escritorio)  
 
• Record Area (Grabar un área) 
 
• Record Window (Grabar una ventana) 
 

4 Presione el icono SMART Board  en la esquina inferior derecha de su pantalla y seleccione Other 
SMART Tools. Seleccione la herramienta que desea utilizar desde el menú deslizable. 
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Recursos SMART  
SMART Resources ¿Qué sigue? 

 
SMART apoya el uso de los productos SMART con un número adicional de recursos, 
incluyendo material de capacitación gratuito en el sitio web de SMART, una comunidad en 
línea para maestros y la versión gratuita del software SMART Ideas® para mapas de 
concepto con cada pizarrón interactivo SMART Board registrado.  
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The SMART Training Center (Centro de capacitación de SMART) 
En el Centro de Capacitación de SMART usted podrá encontrar recursos y soporte adicional de 
capacitación, icluyendo material gratuito de capacitación  y sesiónes gratuitas de capacitación en 
línea. Visite www.smarttech.com/trainingcenter. 

Material gratuito de capacitación 
El material gratuito de capacitación disponible en www.smarttech.com consiste en Referencias 
Rápidas y Ejercicios prácticos 
 
Las referencias rápidas son guías simples de una o dos hojas  que cubren las características de 
los productos SMART.  Tiene un formato ajustado para impresión, para que usted pueda tenerlos 
justo al lado de su pizarrón interactivo SMART Board. 
 
Los ejercicios practicos lo proven de actividades paso a paso, hacienda más fácil el repaso y la 
práctica de lo que usted ya ha aprendido.  

Sesiones gratuitas de capacitación en línea 
Las sesiones SMART de capacitación en línea son conferencias de computadora y teléfono con 
una duración de 30 minutos, que ofrecen una rápida y gratuita descripción de los fundamentos 
del pizarrón interactivo SMART Board. Cada sesión es guiada por un capacitador SMART que 
utiliza productos SMART todos los días. Usted aprenderá como utilizar sus productos SMART 
más eficientemente y tendrá la oportunidad de hacer preguntas 
 
Las sesiones gratuitas en línea incluyen los siguientes cursos:  
 

• Fundamentos del pizarrón interactivo SMART Board 
 

• Fundamentos del  Notebook 
 

• Instalación de su Pizarrón Interactivo SMART Board 
 

• Fundamentos del  SMART Ideas  
 

• Navegue en el sito Web de SMART 
 

• Descubra la comunidad en lina EDCompass para Maestros. 
 
Ofertas nuevas y gratuitas se desarrollan constantemente. Visite el Centro de Capacitación 
SMART a menudo para aprender acerca de las ultimas sesiones.
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EDCompass 
EDCompass es una comunidad en línea donde usted puede compartir recursos e ideas con otros 
educadores en todo el mundo. En el sitio Web  EDCompass  usted encontrará los siguientes 
recursos: 
 

• Recursos gratuitos de aprendizaje para el uso con productos SMART, incluyendo 
actividades para las clases, colecciones de contenido, aplicaciones de software y 
recursos web. 

• Programas de desarrollo profesional para recompensar, reconocer y apoyar a los 
educadores. 

• Investigación sobre la eficacia del pizarrón interactivo SMART en el terreno del 
aprendizaje. 

• Consejo para educadores en el uso de productos SMART, integrando periféricos, 
dominando la escritura y evaluando la tecnología. 

• Tablero de anuncios y cartas mensuales para conectar a un educador con otro y así 
aprender acerca de oportunidades exclusivas de SMART 

 
 

Visite http://edcompass.smarttech.com. 
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Ver y descargar actividades de clase desde EDCompass 
Vea todas las actividades disponibles dando clic en el vínculo Learning Resources  en la parte 
de arriba del sitio Web de EDCompass. Seleccione Lesson Activities desde el lado izquierdo de 
la página, y después seleccione el tipo de actividades que usted desea ver, tales como las 
actividades del  Notebook o SMART Ideas. 
 
Una vez que eligió un tema, le presentarán una tabla que muestra varias actividades. Puede 
clasificarlas por título, por tema, país de origen e incluso por la edad del estudiante para quién es 
apropiada la lección. 
 
Para descargar una actividad siga estos pasos simples: 
1 Dé clic en el título de la actividad en que está interesado. Usted verá una imagen descriptiva 

y un breve sumario de la actividad. 

2  Un vínculo de descarga está visible al lado derecho de la imagen. Dé clic en el vínculo para 
descargar el archivo. Surgirá un cuadro de advertencia para  abrir o guardar el archivo en su 
computadora. 

3 Seleccione Open para iniciar el software y abrir el archivo en su computadora 

 o 

4 Seleccione Save para guardar el archivo en su computadora. Surgirá un cuadro de 
advertencia para seleccionar el lugar donde desea guardar el archivo. 

 
 
  

Click here to 
download the file 
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SMART Ideas Concept-mapping Software (Mapa conceptual) 
La representación visual de la información se vuelve más importante para que los estudiantes 
aprendan las habilidades de pensamiento crítico en el salón de clases. Los mapas de conceptos 
interactivos permiten a los estudiantes explorar un tema agregando múltiples niveles a un mapa 
y seleccionando imágenes para ilustrarlos. El  SMART Ideas concept-mapping no sólo ayuda a 
sus estudiantes a conectar ideas, organizar conceptos y planear – los motiva a aprender.  
 
Los usuarios registrados del pizarrón interactivo SMART Board reciben una versión gratuita del  
SMART Ideas. Desde www.smarttech.com, simplemente selecciona Product Registration 
desde  Quick Links y completa el proceso de registro. 
 

Qué es un Mapa Conceptual? 

 
 

Creando símbolos con el  SMART Ideas  
 
Abra SMART Ideas y seleccione Blank Diagram.  
 
1 Escriba Crear un símbolo. 
2 Presione Enter. 

 
 

Vinculando Símbolos con Conectores   
 
Seleccione el símbolo que desea conectar a otro símbolo. 

                                                           
 
 
 
Si usted está trabajando en un pizarrón interactivo SMART Board simplemente dibuje una línea 
para conectar sus símbolos. 

             
 
 

1. Seleccione el icono 
conector  

3. Un conector vinculará los 
símbolos.  

2. Arrástrelo hacia el símbolo que desea 
vincular 

1. Elija los símbolos 
 que desea conectar 2. Dibuje una línea de un  

símbolo a otro 

3. Un conector vinculará los 
símbolos. 
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Etiquetando conectores 
Etiquete un conector para mostrar como las ideas se relacionan unas con otras. 
 

 
 

Ampliar y colapsar Diagramas de Arbol  
Seleccione un símbolo vinculado a otro símbolo. La conexión puede ser colapsada o ampliada. 
  
 
 

                             
 
                    

Creando Diagramas en Capas 
Usted puede crear un número ilimitado de sub niveles dentro de su diagrama que puede ser 
usado para dar más información acerca de ideas específicas. Cada sub nivel contiene un nuevo 
diagrama y es parte de su archivo original de SMART Ideas. 

Creando un Nuevo sub nivel 
 
1 Presione la flecha verde en la esquina superior izquierda del símbolo seleccionado. 
2 Se abrirá un nuevo espacio de trabajo en blanco. Cree el sub nivel de su diagrama. 
3 Cuando usted esté trabajando en un sub nivel,  use los vínculos que aparecen en la  
esquina superior izquierda del área de trabajo para navegar de regreso a su diagrama  
principal. 
 
Presione la flecha verde de su símbolo en cualquier momento para regresar al sub nivel del 
diagrama.  
 
 

Presione aquí para 
colapsar su diagrama 
de arbol  

Presione aqui para 
ampliar su diagramde 
arbol  

Before  After Before After

1. Presione dentro 
 de la línea punteada. 
 

3. El conector quedará etiquetado. 
 

2 Escriba para etiquetar su 
conector. 
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Resumen 
S¿MART Resources ¿Cómo se supone 
que voy a recordar 
todo ésto? 
 
La mejor manera de volverse experto con cualquier habilidad es utilizarla. Tome la 
información que ha aprendido hasta ahora y aplique el conocimiento más apropiado a su 
trabajo. Una vez que se sienta cómodo usando los fundamentos, usted puede siempre 
regresar a este Libro de Trabajo como referencia o visitar el Centro de Capacitación 
SMART (www.smarttech.com/trainingcenter) y tomar una sesión gratuita en línea. Usted 
puede visitar siempre EDCompass (http://edcompass.smarttech.com) para ideas en las 
clases.       
 
Algunas guías de Referencia Rápida que tal vez desee tener cerca de su Pizarrón 
Interactivo SMART Board las puede encontrar en las siguientes páginas. Más guías de 
Referencia Rápida pueden ser descargadas del Centro de Capacitación SMART sin costo 
alguno. 
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Referencia Rápida 

Barra de Herramientas Notebook™  
La barra de herramientas de Notebook le da acceso a un número de herramientas para trabajar con su archivo de 
Notebook y cambiar las propiedades de los objetos en el archivo. Como es predeterminado, la barra de herramientas 
aparece, hasta arriba de la página Notebook. Si usted encuentra más conveniente tener la barra de herramientas hasta 
abajo de la pantalla, seleccione un área de espacio libre en la barra de herramientas y arrastre hacia abajo.  

 

Botón Use ésta herramienta para… Botón Use ésta herramienta para… 

 
Crear un Nuevo archivo Notebook en blanco 

 
Abrir la barra de herramientas Capture. La barra de 
herramientas Capture se describe abajo. 

 
Abrir un archivo de Notebook 

 
Seleccionar cualquier objeto de la página 

 
Guardar su archivo 

 
Escribir o dibujar en una página de Notebook con la 
herramienta de pluma 

 
Pegar los objetos del portapapeles en un archivo 
de Notebook  

Escribir o dibujar en una página de Notebook  con la 
herramienta de pluma creativa  

 
Zoom 

 
Borrar la tinta digital en una página de Notebook  

 
Deshacer la última acción realizada  

 
Dibujar una línea 

 
Rehacer la última acción realizada 

 
Crear una forma 

 
Borrar cualquier objeto seleccionado  

 
Crear un diálogo de texto para escribir en una página de 
Notebook  

 
Mostrar la página previa de Notebook 

 
Establecer el color actual de una herramienta, forma u 
objeto. 

 
Mostrar la página siguiente Notebook  

 
Seleccionar la anchura de línea de una herramienta u objeto 
seleccionado 

 
Insertar una página en blanco inmediatamente 
después a la página actual.  

Seleccionar la transparencia de una herramienta  u objeto 
seleccionado 

 
Mostrar/ocultar la sombra de pantalla 

 
Seleccionar las propiedades de línea de una herramienta u 
objeto seleccionado 

 
Abrir la vista de pantalla completa    

 
Barra de herramientas Capture  
La barra de herramientas Capture le permite capturar una imágen de una porción de la pantalla, una ventana o la 
pantalla completa a una página de Notebook. Para acceder a la barra de herramientas Screen Capture, presione el botón 
Capture  en la barra de herramientas de  Notebook 

Elemento 
del menú 

Seleccione este elemento del menu para… 

 

Capturar una porción de la pantalla. Presione y arrastre diagonalmente para marcar el área que 
quiere capturar. Suelte la presion una vez que el área ha sido seleccionada. Su captura será 
guardada en una página de  Notebook. 

 

Capturar una ventana activa o una porción de la ventana activa. Presione dentro de la ventana  que quiere 
capturar. Suelte la presión una vez que la ventana deseada aparezca como un área marcada. Su captura será 
guardada en una página Notebook. 

 

Capturar la pantalla completa. Establezca su pantalla en la manera que desea que se vea. Luego presione el 
botón de Capture Screen. Su captura será guardada en una página de Notebook. 



 

 

The Object Drop-Down Menu (El Menú deslizable del Objeto) 
El Menú deslizable del Objeto le da acceso a las funciones utilizadas más comúnmente cuando se trabaja con un objeto. 
Accese al menú seleccionando un objeto y luego presione la flecha que aparece en la esquina superior derecha del 
objeto.  

 

Elemento 
del menú 

Seleccione este elemento del menú para… 

Clone Hacer una copia exacta del objeto seleccionado. 

Cut Eliminar la selección del archivo actual de Notebook y colocarlo en el portapapeles. 

Copy Copiar la selección y colocarla en el portapapeles. El objeto u objetos originales permanecen en la página de  
Notebook. 

Paste Insertar el contenido del portapapeles en la esquina superior izquierda de la página Notebook. 

Delete Borrar la selección del archivo actual de  Notebook. 

Check Spelling Revisar la ortografía de un objeto de texto seleccionado. 

Lock in Place Bloquear el objeto seleccionado para asegurar que sus propiedades no puedan ser cambiadas.  

Grouping Agrupar o desagrupar objetos. Elija Group (Agrupar) para tener uno o más objetos seleccionados que actúan 
como un solo objeto. Seleccione Ungroup (Desagrupar) para manipular los objetos en un grupo 
individualmente. Ungroup también separará los objetos de dibujo a mano alzada o escritos a mano an trazos 
de pluma individuales. 

Order Cambiar los objetos que están en frente o detrás de otros objetos. Utilice el comando Bring Forward o Send 
Backward para reordenar un objeto de una capa a la vez. Traiga a un objeto directamente a la capa de encima 
de la página con el comando Bring to Front. Utilice el comando Send to Back para mandar a un objeto hasta 
la capa del fondo de la página. 

Hiperlink  Agregar un vínculo a una página web o un archivo. Un botón de hipervínculo  aparece en la esquina inferior 
izquierda del objeto. Presione el botón para abrir el buscador web o aplicación requerida y vaya al lugar 
seleccionado. 

Properties Modificar las propiedades de un objeto. Las propiedades disponibles para la modificación dependen del tipo de 
objeto que usted ha seleccionado. Las opciones incluyen Línea de Borde, Color de relleno, Propiedades de 
Línea, Transparencia y Fuentes. 

 
Elementos especiales del menú 
Algunos objetos tienen elementos especiales del menú que no están disponibles para otros objetos. El texto de escritura a mano 
presenta el elemento de menú Recognize. Los objetos de Macromedia® Flash® ofrecen elementos del menú de  Flash. 

Elemento del 
menú 

Seleccione este elemento del menú para… 

Recognize Transformar sus notas escritas a mano en texto mecanografiado. 

Flash Controlar su archivo de Flash durante una presentación con los archivos de comando  de Flash. 

Play comienza a reproducir una película de Flash pausada. 

Rewind lo lleva al inicio del archivo de Flash y pausa la película.  

Step Forward Avanza el archivo un poco y pausa la película.  

Step Back retrocede el archivo un poco y pausa la película.  

Loop activar o desactivar looping. Un archivo Flash se repite continuamente.  Los archivos Flash hacen looping 
de modo predeterminado.         
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Referencia rápida 

SMART Board™ Start Center (Centro de Inicio SMART Board) 
Usted está a un solo toque de las características y apliaciones utilizadas más frecuentemente con el Start Center. 

Abriendo el Start Center 
Es fácil arbir el  Start Center. Presione el botón SMART Board  en la Barra de Tareas de Microsoft® Windows® en la 
esquina inferior derecha de su pantalla y seleccione Start Center de su menú.  
 

 
 
NOTA: El Start Center sólo está disponible cuando usted está trabajando en un pizarrón interactivo SMART Board o un 
producto Sympodium™. 

Qué hacen los botones? 
Hay ocho botones en la barra predeterminada de herramientas Start Center. Siete de los botones se utilizan para 
ejecutar las aplicaciones más comunes. El botón More le permite personalizar el Start Center para que haga lo que 
funcione mejor para usted.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ejecuta el Notebook 

Ejecuta el SMART 
Video Player 

 

Ejecuta el centro 
de Ayuda SMART 
Board  

Ejecuta el SMART 
Recorder 

Ejecuta el teclado en 
pantalla 

Ejecuta el panel de 
Control 

Botón More  

Notification Area 

Ejecuta Floating 
Tools 



 

 

 

 

Personalizando el Start Center (Centro de Inicio) 
Agrega herramientas o aplicaciones al Start Center para hacer más fácil su trabajo en el SMART Board. Para 
personalizar su Start Center presione el botón More y seleccione Customize Start Center.  
 
 

 
 

  Seleccione 
una 
herramienta 

Presione Remove para eliminar una 
herramienta de la barra de 
herramientas actual 

Cambie el orden de 
la barra de 
herramientas actual 

Presione para 
aceptar los 
 cambios 

Presione para 
rechazar los cambios

Presione para 
encontrar y 
agregar una 
apliacion no 
listada en 
Available Tools 

Botón More 
 

 Presione Add para mover una herramienta 
seleccionada de Available Tool a la barra 
de herramientas actual 
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Formato muestra de retroalimentación 
 
Por favor, tómese un momento para completar este cuestionario con todo el detalle posible. Su retroalimentación es una parte integral para mejorar 
nuestras sesiones futuras de entrenamiento. Todos los comentarios son bienvenidos. 
 
 
Por favor indique la opción que se más apegue cuando esté de acuerdo o en desacuerdo con las siguientes aseveraciones: 
 
1= muy en desacuerdo  2 = en desacuerdo   3 = de acuerdo  4 = totalmente de acuerdo 
 
 

1 La sesión fue bien diseñada (ritmo, tiempo adecuado para Q y A, etc.) 1 2 3 4 

2 Recibí información en esta sesión que puedo utilizar de inmediato en mi trabajo. 1 2 3 4 

3 El libro de trabajo de principiante es un recurso d aprendizaje efectivo. 1 2 3 4 

4 
Las actividades me ayudaron a familiarizarme con la funcionalidad del pizarrón interactivo SMART 

Board 
1 2 3 4 

5 El capacitador utilizó técnicas de buena presentación 1 2 3 4 

 
 
 
¿Qué le gusto más de la sesión? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
¿Cómo mejoraría la totalidad de la experiencia de la capacitación? (Por favor siéntase libre de comentar tanto del libro de trabajo como de las 
actividades) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Gracias por tomarse el tiempo para completar este cuestionario. Agradecemos su retroalimentación. Si tiene alguna pregunta o preocupación no citado 
aquí, por favor pregunte a su entrenador o mande un e-mail a training@smarttech.com. 
 
 


